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PPC'S SMART PRACTICE AIDS — RISK ASSESSMENT
QUICK REFERENCE

Create a Client Engagement

PPC’s SMART Practice Aids® is an innovative audit tool that brings advanced functionality to your licensed
PPC'’s Practice Aids products, allowing auditors to optimize the overall audit planning process.

You can create a client engagement from a PPC Title or from a Master Engagement.
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|D New -"Z_'ﬁ"c..} Client Engagement (From PPC Title)...  Ctrl+R
Open L§ Client Engagement (from Master)...
Close Master Engagement. ..

¢ Creating an engagement from a PPC Title creates a blank engagement based on the PPC title you
select.

o Creating an engagement from a Master Engagement imports any information from the previously
generated master engagement into the new client engagement.

For support, go to http://support.rg.thomsonreuters.com, or call 800.431.9025.
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ALLOW MULTI-USER

Allow Multi-User

You have the option, when opening an existing engagement, to allow multiple users to work on the
engagement at the same time. Otherwise, other users who have access to the engagement will only be able
to open the engagement in read-only mode.

To set the option to allow multi-user:
1. Onthe File menu, click Open (or click the Open button on the tool bar).

2. Select the Allow multi-user for this engagement check box. This option allows multiple users to
edit parts of the engagement at the same time.

To unlock a locked engagement:
1. Onthe Tools menu, click Options, and then click Application Settings.

2. Click the Multi-User tab of the Options — Application Settings window.

Create a SMART Start Client Engagement

If you select practice aids titles with SMART Start data, you will see a new option on the Create Client
Engagement window that lets you enable SMART Start, an audit process for small, noncomplex entities.

To create a SMART Start client engagement:
1. Onthe File menu, click New.
2. Click Client Engagement (from PPC Title).
3. Select a practice aid title for this engagement. (Only installed practice aids titles are listed.)

If you select a practice aids title with SMART Start data, you may see a new option called "Use
SMART Start?."
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CREATE A SMART START CLIENT ENGAGEMENT
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Note: Click the Help me decide link for a summary of benefits, cautions, and other considerations
when using SMART Start.

The system automatically selects the Risk Assessment module. Then it disables and deselects the Internal
Control module and provides the ability to enable Disclosure and Field Work.

The system creates a new client engagement, populates the engagement with SMART Start content, opens
the engagement to the first planning form in the engagement, and places the SMART Engagement Setup
Questions report in the engagement as the first form in the planning area (immediately before Identified
Risks).
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SMART ENGAGEMENT SETUP QUESTIONS

SMART Engagement Setup Questions

Answer SMART Engagement Setup Questions to automatically streamline and tailor your practice aids and
audit programs based on your answers. You can click the Explain link next to each question for an
explanation. Planning questions not applicable to your client’s situation will be removed automatically, and
audit programs will be tailored automatically.
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GENERAL NAVIGATION

General Navigation

SMART Practice Aids uses an easy-to-navigate three-pane design. Take a few minutes to get familiar with
the names of the interface features. This will help you better understand the Help's step-by-step procedures
that show you how to use SMART Practice Aids.
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Navigation Pane

You can hide or display the Navigation pane and right pane using the "pin" icons that appear at the top of the
panes.
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STEP 1 - IDENTIFY RISK

Step 1 - Identify Risk

As you complete the planning forms in Step 1 - Identify Risks, you can add to the engagement any risks that
could result in material misstatement of the financial statements.

To access this window, click the Add Risk button in the Identified Risks right pane.

[1dentified Risk

Describe Risk:

Improper reverue recognition because of fraud ;_]

j |

Isthis a fraudrisk? @ Yes  No
1s this a sigrilficant risk that requres spedal audit consderation? (8 Yes  No
Selact the augit aregs affected by the risk or, if the risk affects the financial statement
in general, selact Overall Financial Statements:

[~ €ash ™ Payro
7 Investments and Derivatives [ wer
E7 suppart, Recelvables, and Receipts [~ Prope
I Program Service Fees, Revenue, and Recawabiles [~ Othe
I™ Donated Materiak, Faciities, and Services [~ Debt
[~ Expenses for Program and Supparting Services and Accounts Payable and Other Lishilties [ Net 2
. |
Or

[~ Overall Fnancial Staterents

Users who have enabled SMART Practice Aids — Internal Control for the engagement will see an
additional option below the assertions list asking if you want to indicate transaction classes affected by the
risk.

Do you want to indicate the transaction classes . ’
affacted by this rsk? (It may be helofl when Oves [ <cprevous |_Froish ] [ Cancel |
identifying significant transaciion dasses.) (=)Mo

The risks you identified appear in the Identified Risks area in the right pane.

Ady symbol appears next to any risk for which you opted not to select the transaction classes affected by the
risk.
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STEP 2 — ASSESS THE EFFECTS OF RISK

Step 2 — Assess the Effects of Risk

The second step in completing an engagement is to assess how the risks
that you identified when completing the planning forms in Step 1 affect the
audit procedures you will perform. Each audit area is represented by an B2 Assess Effects of
Assess Effects of Risks window that displays the identified risks Risks

organized by affected assertion.
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As you complete each audit area's risk assessment, click Next to move to the next audit area.

Overall Financial Statement Risks

In the Overall Financial Statement risks form, review the planned audit response to identified risks and make
changes if applicable.

All risks identified as affecting the financial statement in general are listed in the Identified Risks field. For
the risk management override of controls, a response is provided. You can edit the planned audit response
text, add procedures/comments, or make changes to the text as needed.

Step 3 — Review and Modify Your Audit Programs

You perform this step in the Review and Modify Audit Programs section in the Navigation pane. Here you
access the suggested audit procedures for all audit area and modify them if necessary.
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STEP 3 — REVIEW AND MODIFY YOUR AUDIT PROGRAMS

Center Pane Contents

The center pane lists suggested audit procedures for the audit area. You can click a + icon to expand a
selected category or procedure section.
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The right pane lists all audit procedures available for the audit area. Use the + and -icons to expand and
collapse the different procedure sections. Procedures currently included in your audit program appear in light
gray text. Other procedures available for selection appear in dark text.

Prior Period and Current Period Procedures

There are navigational aids to help identify differences between prior period and current period audit
procedures.

In the center pane a modified step flag icon is displayed next to each procedure that contains differences
between the current period and prior period.

Inventory Dbservation

Assertions Steps

Planning

8 Observation |

Ef2, € [V] | B #Observe the physical inventory count for raw materials and
finished goods,

Click the flag icon to display the Reset Procedure window. The prior period, original PPC procedure - current
period , and modified current period versions of the procedure text are displayed for comparison. Select the
version of the procedure text that you want to use for the current period. Click OK to confirm the change.

A flag icon also appears in the right pane for each audit procedure step that was selected in the prior period.
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GENERATE DIAGNOSTICS REPORT

Add, Modify, Delete Procedures

To add a procedure:
You can add pre-defined procedures or your own custom procedures.

o To add pre-defined procedures to your audit program, drag and drop a procedure in the right pane to
the center pane.

o Toadd your own custom procedures, select Procedure Above or Procedure Below (depending on
where you want it to appear) from the Insert menu.

To modify a procedure:

Double-click any procedure to modify it. You can also select Modify from the Edit menu to edit a selected
procedure. To assist reviewers, your changes appear in red.

To delete a procedure:

To delete a procedure you have added, highlight the procedure in the center pane and select Delete from the
Edit menu.

You can also drag and drop unwanted procedures from the center pane to the right pane using your mouse to
remove procedures from your audit program.

Generate Diagnostics Report

After creating an engagement and completing all pertinent forms, you are ready to run the Diagnostics
Report. Review this report to discover inconsistencies or other conditions that you should consider before
generating your planning forms and audit programs.

To generate the Diagnostics Report:

On the Navigation pane, select Generation from the Navigation drop- Generation v

down list. . ¥ 1. Diagnostic
Feports

2, Generate
Documents

Generate Planning Forms and Audit

Programs

The final step in the risk assessment process is to generate the engagement's planning forms and audit
programs.
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GENERATE PLANNING FORMS AND AUDIT PROGRAMS

1. Inthe Navigation pane, select Generation from the drop-down list.

2. Expand Generate Documents and click Planning Forms.

3. Select the check box for each planning form you want to generate.

4. Click Create Practice Aids to generate fully functional Practice Aid
versions of the selected planning forms. »-Planning Forms
The Create Practice Aids window appears. Audit Programs

5. Either type in the directory path or use the Browse button to locate Checklist and
the folder where you want to save the planning forms. Disclosures

Note: To generate audit programs, the procedures are similar to
those for generating planning forms, except that you perform the steps on the Generate Audit
Programs window instead of on the Generate Planning Forms window.

To use the print preview feature:
Click the print preview icon L"] next to the form you want to preview.

The print preview opens in the Preview window.
To use the preview right-click feature:

Once you open a document or form in preview mode (see the previous procedure), you can right-click
anywhere in the document to bring up a shortcut menu. This menu has options that let you print the previewed
document, add to favorites, create a shortcut, and export to Microsoft Excel.

Set Filter Option

To use afilter for CX-5 forms using SMART Practice Aids - Internal Control, click the Set Filter icon T next
to the CX-5 series.
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Select the check boxes for the controls you want to display in the preview or generated document.
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ENGAGEMENT ROLLFORWARD

Engagement Rollforward

The SMART Practice Aids Rollforward feature provides two ways to create a new client engagement and
transfer prior-period engagement answers and customizations into it:

¢ Rollforward to a new client engagement

o Merge with a master engagement

Rollforward the Client Engagement to a New Client Engagement

This option is considered the typical rollforward method. It creates a new engagement based on an equal or
newer version of the Practice Aid title used to create the original engagement, then transfers the selected
prior-period engagement data into it.

Merge the Client Engagement with a Master Engagement

This option is useful for firms that want their auditors to begin with the current master engagement (created
and maintained by the firm), but want the new engagement to include responses and other data from the prior-
period engagement. It allows firms to effectively use master engagements without losing documentation that
was created in the prior period client engagement. When this option is chosen, the selected master
engagement and prior-period client engagement are merged as follows to form the new client engagement.

To rollforward a client engagement:

1. Open an engagement to be rolled forward.

2. Onthe File menu, click Rollforward.
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TooLs MENU

Tools Menu

These options are available from the Tools menu on the main menu bar.

Name Description Shortcut
Add Risk Add a new risk to the current form when working in Step | Alt+ T +
1 - Identify Risks and Step 2 - Assess Effects of Risks. A
Regenerate Clears the audit program and reselect procedures based
: : N/A
Audit Area on the current risk assessments.
Clear Risk Clears all risk assessments for the current audit area N/A
Assessment | and sets them back to "Select."
Workpaper Runs the Workpaper Status Report. (If you have Field N/A
Status Report | Work installed, this option will be enabled.)
The Transfer Engagement submenu has the following
options.
Name Description Shortcut
Transfer an
Client | existing client
Transfer Engage- | engagement to F10 At+T+T
Engagement ment another
database.
Transfer an
Master | existing master
Engage- | engagement to N/A
ment another
database.
Receive . . .
Engagement Import an existing engagement into your database. Shift F10
Affirm Confirm a prior period assertion for the current period. Alt ;/IT *
Affirm Row Affirms the responses in the entire row of a table. N/A
Affirm Table | Affirms the responses in the entire table. N/A
. . . . . . Alt+T+L
Affirm All Confirm all prior period assertions for the current period.
Update Update an audit program within the current engagement
SMART toinclude user's changes to the generated version of the N/A
Engagement | same audit program document.
Wrap-up The Wrap-up submenu has the following options. N/A
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TooLs MENU

Name Description Shortcut
Nam- o Short-
Description
e cut
Select and
Delet- | delete backup
e files that have Alt+T
Back- | been created W

up using the File
Files | > Backup

action.
Select and
(I;)elet- delete files
Trans- that have been |Alt+ T
transferredto |+ W
fer
Files another
database.

Clear | Select and

Unus-| delete Alt+T
ed unnecessary |+
Data |data.

The Options submenu has the following options.

Descrip- | Short-

AT tion cut

Define
default file
locations
for
engage-
ment Alt+T
backups, |+O+F
transferred Alt+T+
engage- O
ments, and
generated
Practice
Aids.

Set the
location of
Content reference
Settings materials
such as
PPC

File
Locations
Options

Alt+T
+0+8S
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TooLs MENU

Name Description Shortcut

Descrip- | Short-

AET tion cut

Guidance
and
Check-
point.

Change
the
database
Pointto | for your Alt+T
Different | PPC's +0+P
Database | SMART
Practice
Aids client.

Set the
database
to use for
loading
your firm
Point to libraries. (If
Firm you have
Library the
Database | Disclosure
module
installed,
this option
will be
available.)

N/A

Change
Appli- youruser |Alt+T
cation name; set |+ O+A
Settings | multi-user
options.

Access From Virtual Office CS

When you access SMART Practice Aids from Virtual Office CS, the following menu options become
available on the Tools menu under the VO Options submenu. These menu options are available only from
the Virtual Office-launched version.

Name Description Shortcut
Set/Update Set up initial login or update existing login N/A
Login information.
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TooLs MENU

Information

Refresh Product | Refresh list of licensed product titles to ensure

List availability via Virtual Office CS. N/A
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